Mazda Miata/GT-X/MX-5

Product Warranty Statement
All products manufactured or distributed by Electronz Ltd are subject to the following,
and only the following, LIMITED EXPRESS WARRANTIES, and no others.
For a period of one (1) year from and after the date of purchase of a new Electronz Ltd
product, Electronz Ltd warranties and guarantees only to the original purchaser that such
a product shall be free from defects of materials and workmanship in the manufacturing
process. A product claimed to be defective must be returned to the place of purchase.
Electronz Ltd, at its sole option, shall replace the defective product with a comparable
new product or repair the defective product.
This expressive warranty shall be inapplicable to any product not properly installed or
properly used by the purchaser or end user, or to any product damaged or impaired by
external forces. This is the extent of warranties available on this product. Electronz Ltd
shall have no liability whatsoever for consequential damages following from the use of
any defective product or by reason of the failure of any product. Electronz Ltd specifically
disclaims and disavows all other warranties, express or implied, including, without
limitation, all warranties of fitness for a particular purpose, warranties of description,
warranties of merchantability, trade usage or warranties of trade usage.
For off-road use only, not intended for highway vehicles.
Electronz Ltd License Agreement
The programme in this system is licensed not sold. Electronz Ltd grants the user a license
for the programme only in the country where the programme was acquired. No other
rights are granted under this license and the programme may only be used on one
machine at a time. If the programme is transferred a copy of this license and all other
documentation must be transferred at the same time. The license may be terminated by
the user at any time. Electronz Ltd may terminate the licence if the user fails to comply
with the terms and conditions of this license. In either event the copy of the programme
must be destroyed.
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Introduction
Thank you for purchasing your Link Plug-In Engine Control Unit (ECU). Link G4+ ECUs are an advanced,
fully programmable microprocessor controlled Engine Management System.
The G4+ software platform boasts an impressive list of features giving a new level of user adjustment. This
flexibility allows the tuner to have complete control over the engine management system. G4+ software
employs high resolution fuel and ignition tables with configurable load and RPM centres. When coupled with
up to six dimensional fuel and ignition mapping, barometric pressure compensation and intake air
temperature correction this gives an unprecedented level of tuning accuracy. All Link G4+ ECUs are in field
upgradeable, there is no need to return the unit for software updates.
All Link G4+ Plug-In Engine Management Systems are designed with flexibility and ease of installation in
mind. Link Plug-In systems are designed to either replace the circuit board inside the factory ECU
enclosure, or entirely replace the factory ECU. This provides an invisible install that requires minimal
modification to vehicle wiring and ECU mounting.
Link Engine Management Systems are designed with the final result in mind. Not only do they boast an
impressive range of performance features, but are designed with a focus on safety, reliability and drive-ability.
However, the ultimate success of your engine management upgrade is determined by how well the system is
installed and tuned.
Installing and tuning any after market engine management system is not to be taken lightly. G4+ ECUs give
the tuner the control & flexibility that only top after-market engine management systems in the world can
provide. While every effort has been made to keep G4+ ECUs as user friendly as possible, it should be
recognised that added features bring added complexity.
The complete setup of your ECU can be divided into two important tasks:
1. This manual covers the installation of your G4+ ECU. While it is not strictly essential that this work is
performed by an automotive electrician, the knowledge and tools available to these professionals makes it
highly recommended. Regardless of who does the installation, it is of utmost importance that instructions
provided in this manual are followed exactly throughout the installation.
2. Once the G4+ ECU has been installed it will need to be tuned using a laptop computer with PCLink
software. Information on the configuration and tuning of the G4+ ECU is detailed in the online help section
of PCLink. G4+ ECUs are shipped pre-loaded with a base configuration that should be close enough to
get most engines running after a few application specific adjustments have been made. While hearing the
engine running on the new ECU for the first time is always a satisfying feeling, it is important to realise that
the job is not complete. The amount of tuning performed and the experience of the tuner are the two most
important factors in determining how happy you will be with your engine management system.

1.1

Safety Notice
Your Link Plug-In ECU is designed to enhance the performance of your vehicle. However in all cases, your
vehicle must be operated in a safe manner. Do not tune your vehicle while operating it on public roads.
Obey road rules at all times.
WARNING!
Failure to follow all installation and operating instructions may result in damage to
the Link ECU, personal injury, or harm to property.

1.2

Disclaimer
All care has been taken to ensure the pin outs and interconnections of the ECU to the vehicles wiring
harness are correct. However due to variations between vehicle models it is the installers responsibility to
check wiring connections BEFORE installing the ECU. Link will not be held responsible for any damage
caused by the incorrect installation of this product.
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Support Options
Should any issues arise during installation, the following options exist for technical support:
1. PCLink help, press F1 while running PCLink
2. Contact your nearest Link dealer. A Link dealer list is available on our website.
3. Link website: www.LinkECU.com
4. Technical Support Email: tech@LinkECU.com
5. Online Discussion Forum: Available from the Link website.
The majority of questions received by the technical support team are clearly answered in the manuals. To
speed up your technical inquiry please consult the manuals to make sure that your question has not already
been answered.
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Pre-Installation
Before installing theLink G4+ ECU into the vehicle some pre-installation checks must be performed.

2.1

Injector Impedance
Injector impedance is important and needs consideration before installing the ECU.

2.1.1

Mazda ECUs
The Mazda G4+ Plug-In ECUs are NOT designed to be used directly with low impedance injectors.
All models this ECU is designed for are fitted with high impedance injectors from factory. This means that
the ECU is plug-in compatible with factory fitted injector combinations on all models. If low impedance
injectors are to be fitted then a ballast resistor pack will be required. Contact your Link dealer for further
information.

2.2

Required Modifications
Modifications may be required on some vehicles to make the Link G4+ Plug-In ECU function fully.

2.2.1

Mazda Piston Engine ECUs
Some models supported by the Mazda MX5/Miata/GT-X G4+ Plug-In ECU require additional installation
modifications. The following modifications may be required:
Fuel Pump Control – Some models have a switch fitted inside the AFM that disables the fuel pump when
the engine is drawing no air. Depending on the way the AFM is wired it may be necessary to either
bypass the AFM switch or wire a separate ECU controlled Fuel Pump Relay.
Throttle Position Sensor (TPS) – Miata/MX5 1600cc models do not have a factory fitted TPS. A TPS
should be installed and wired to the ECUs expansion connector. This is required for functions such as
acceleration enrichment, idle speed control and motor sport features.
The Mazda GTX has four injectors, but they are operated in group fire mode. In PCLink connect to the ECU
and go to the Fuel Setup section. Store the base-map (F4) and switch the ignition off and back on again.
Change the Injection Mode to Multi-Point Group and also set the Active Drives to INJ1-2. Go to the
Auxiliary Outputs - Fuel section and confirm that Injector Drive 3 and 4 are set to OFF.

(c) 2009 Link ElectroSystems Ltd
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Installation
This guide provides information on correctly and safely installing your new Link G4+ Plug-In ECU.

3.1

ECU Handling Procedures
WARNING!!!
The following installation process will require handling of both the Link ECU and
factory ECU. Both of these are highly sensitive to electrostatic discharge and are
easily damaged. Follow the anti-static precautions given in this manual carefully
to avoid damaging electronic components. Warranty claims for ECUs damaged
by electrostatic discharge will NOT be accepted.

ANTI-STATIC HANDLING GUIDELINES

Your body builds up an electrical charge as you move around. This charge can reach very high
voltages. Whenever given the opportunity this energy will attempt to discharge (usually through
your finger tips!). This can be fatal to most electronic components. Most people have
experienced an electrostatic discharge when they step out of their car or touch a metal bench
top.
1. The following guidelines describe precautions that can be taken to reduce the possibility of
damaging your ECU:
2. Work only on a conductive surface. A clean steel bench is suitable.
3. Always wear a wrist strap that is electrically connected to the conductive working surface.
4. Touch the working surface regularly.
5. Do NOT touch components on the circuit board.
6. Where possible, only handle the ECU by its plastic header.
7. Do NOT carry the ECU around without anti-static packaging.
8. Do NOT touch the bare terminals in the ECU header.
Observing the above procedures will minimise the chance of damaging the ECU. Note that
failure due to static damage often does not appear until well after it was caused.

3.2

Fitting the ECU
Information is provided to assist in fitting the ECU into the vehicle.

3.2.1

Fitting a Mazda ECU
The following steps outline the installation procedure:
1. Ensure the key is in the OFF position and remove the ECU from the vehicle. The factory ECU is located in
either of the following places: RX-7 - on the left A pillar about 20cm above the floor, GT-X - behind the
centre consol, MX-5/Miata - under the passengers foot well carpet. Unplug the wiring harness from the
factory ECU. Remove the 6mm bolts (10mm socket) that retain the ECU and remove the ECU from the
vehicle. DO NOT touch the exposed pins in the factory ECU connector.
2. Remove the factory ECU's circuit board from its enclosure: Ensure you are following the given anti-static
guidelines and ARE WEARING A CONDUCTIVE WRIST STRAP connected to a conductive working
surface. Remove the top cover by removing the side retaining screws. Remove the circuit board by
(c) 2009 Link ElectroSystems Ltd
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removing the corner screws. Hold it only by the plastic header and place it aside.
3. Connect the ECU USB tuning cable and the expansion loom to the Link Plug-In ECU if required.
4. Fit the Link Plug-In ECU: Place the Link ECU on the base plate and carefully fit the four corner screws.
Place the factory ECU in the packaging your Link ECU came in for its protection.
5. Refit the top cover: It may be necessary to widen the slot around the main header to allow cables to exit.
Ensure that any modifications are de-burred to prevent cutting into cable insulation.
6. Reassemble the enclosure and fit the ECU back to the vehicle.
7. Connect the ECU to the factory wiring loom.
8. Do NOT attempt to start the vehicle. Proceed to read through the remaining sections of this manual first.

(c) 2009 Link ElectroSystems Ltd
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Additional Sensors
G4+ Plug-In ECUs offer various options for the installation of additional sensors and devices. As a minimum
it is recommended that all ECUs are installed with a Manifold Absolute Pressure (MAP) sensor and Intake
Air Temperature (IAT) sensor. These parts can be purchased if required from your nearest Link dealer.

4.1

MAP Sensor
It is important that the pressure source for a MAP sensor be taken from a stable pressure source after the
throttle body. It is common to 'T' into the fuel pressure regulators pressure signal. Do NOT share this signal
with other devices such as boost gauges or blow off valves.

4.1.1

Mazda Miata/MX5/GT-X
The Link G4+ Miata/MX-5/GT-X Plug-In ECU supports several options for fitting of a MAP sensor. Any one of
the following options can be used:
1. On Board MAP Sensor – The Link Miata Plug-In ECU has an on board MAP Sensor. This sensor is
suitable for boost pressures up to 1.5 Bar. The on board MAP sensor is wired to AN Volt 3.
2. MAP Through Expansion Connector - The expansion connector provides power, ground, and analog
channels for the connection of a MAP sensor.
3. MAP Through AFM Wiring – A MAP sensor can be wired through the AFMs wiring if required. Connect
the MAP sensor to the AFMs signal and sensor ground wires (consult factory wiring manuals). AN Volt 4
is wired to the AFMs sensor signal.
Make sure that the correct An Volt channel has been selected as MAP sensor in PCLink and a MAP
calibration has been performed before attempting to start the vehicle.

4.2

IAT Sensor
It is highly recommended that an IAT sensor be fitted in all applications to provide an input for correction of
fuel and ignition based on the engines air charge temperature.
An IAT sensor should be fitted in the intake system in a location that accurately represents intake
temperature. The most common location is just prior to the throttle body. Installing in the manifold is not
recommended due to heat soak issues. A fast response sensor must be used in all forced induction
applications.

4.2.1

Mazda Miata/MX5/GT-X
From factory, models supported by the Link G4+ Miata Plug-In ECU are fitted with an IAT sensor in the AFM.
This sensor is suitable for use in naturally aspirated applications. In forced induction application a suitable
fast responding IAT sensor must be fitted just prior to the throttle plate. The Link G4+ Miata Plug-In ECU
supports the following options for IAT sensor installation:
1. AFM IAT – In naturally aspirated applications the AFMs IAT sensor can be used. The AFM IAT sensor is
wired to An Temp 2.
2. IAT Through AFM Wiring – An IAT sensor can be wired through the AFMs wiring if required. Connect the
IAT sensor to the AFMs IAT and sensor ground wires (consult factory wiring manuals). An Temp 2 is wired
to the AFMs IAT sensor.
3. IAT Through Expansion Connector – An IAT sensor can be wired directly to the ECU through the ECUs
Expansion Connector.

4.3

Expansion Connector
The expansion connector is provided to allow easy connection of additional ECU inputs. An “expansion cable”
needs to be purchased from your Link dealer.
Important points when wiring to the expansion connector:
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Do not overload the +5V Out pin. Although this is protected against ECU damage the +5V out signal also
provides power for other sensors.
Do not connect the ground pin to chassis ground. This could cause ground loops and introduce
unnecessary interference. Use this pin only to ground external sensors that are isolated from chassis
ground.

4.3.1

Mazda Miata/MX5/GT-X
The following expansion connector inputs/outputs are provided:
Gnd

Sensor Ground Only

+5V Out

Low Current +5V Supply

An Volt 5

Analogue 0-5V input

An Volt 6

Analogue 0-5V input

DI 6

Digital Input

Temp 3

Temperature sensor input

(c) 2009 Link ElectroSystems Ltd
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PC Tuning
G4+ ECUs require PC/laptop tuning using the PCLink Tuning Software application running on a Windows
based computer. PCLink may be downloaded from www.LinkECU.com. Note that when new versions of
PCLink are released they are posted on the website and may be downloaded at no cost. Also note that G4+
ECUs must be used with the correct version of PCLink.
IMPORTANT!
The G4+ ECU has on board USB.
BEFORE connecting the ECU to your laptop, the USB drivers must be installed.
Failure to install the drivers on your laptop first may result in windows assigning
incorrect drivers. These drivers will not work with the G4+ ECU and are difficult to
uninstall. The correct USB drivers are installed as part of PCLink installation, as
described in the following section. Should internet download not be practical, a
copy of the drivers on CD can be obtained from your nearest Link dealer.

5.1

Installing PCLink
Due to the frequent updates PCLink is no longer shipped with each ECU. You will be required to download
the latest version of PCLink from: www.LinkECU.com
Should access to an Internet connection be impractical, the latest version of PCLink can be requested from
your nearest Link dealer on CD.
Installing from the web
1. Go to the above website and navigate to the downloads and software updates section.
2. Download the latest version of PCLink. When prompted to run or save the file, select save. It is
recommended to save this file on the desktop.
3. Double click the saved file and follow on screen instructions.
4. When prompted to install USB drivers, select yes. This may take some time.
5. When installed, open PCLink by double clicking on the icon that has been placed on the desktop.
Installing from a CD
1.
2.
3.
4.
5.
6.
7.

5.2

Insert the PCLink disk into you computer’s CD ROM drive.
Open 'My Computer'
Double click your CD ROM drive.
Double click the file labelled PCLinkSetup.exe (or similar name).
Follow the on screen instructions.
When prompted to install USB drivers, select yes. This may take some time.
When installed, open PCLink by double clicking on the icon that has been placed on the desktop.

Communicating With Your ECU
After PCLink installation, you will be able to connect the G4+ ECU to the laptop to perform set-up and tuning
work.
1. Connect the ECU to your laptop using a Link G4+ ECU USB Cable. If not supplied with the ECU, these
can be purchased from a Link dealer. No other adapter or cabling is required. Connect the cable to the
connector labelled USB.
2. If this is the first time you have connected a G4+ USB ECU to your laptop follow the driver installation
instructions that appear. When prompted if you want to install drivers select 'Continue Anyway'.
3. Start PCLink by double clicking on the PCLink icon on the windows desktop.
4. Switch the key to the ON position. This will provide power to the ECU.
5. In PCLink, under the 'Options' menu, select 'Connection'. The connection options dialogue will open.
Select the correct COM Port number from the drop down list or select auto for automatic com port
detection.
6. PCLink offers both mouse and keyboard control. To establish a connection between the PC and ECU
press the F3 key. The same process can be used to disconnect. If a successful connection is
established, PCLink will download settings from the ECU, otherwise you will be warned that an error has
occurred.
(c) 2009 Link ElectroSystems Ltd
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7. Make sure the connection shows “ONLINE” in the top right corner of PCLink.
8. To permanently STORE any changes made to the ECU press F4. If this is not done before turning the
ECUs power off all changes made will be lost.
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Pre-Start Configuration
Before starting the vehicle, important pre-start configurations need to be made.

6.1

Firmware Version
It is recommended that the Link G4+ ECU is running the most up to date firmware. Firmware version
information can be obtained by connecting to the ECU with PCLink and selecting 'ECU Information' under the
Help menu.
The latest firmware can be downloaded from our website with PCLink.
It is recommended that this is performed by an experienced Link dealer as new features may need to be
properly configured.
The firmware can be updated by selecting 'Update Firmware' under the 'ECU Controls' menu in PCLink.
Follow the on screen instructions to complete the firmware update process.

6.2

Base Configuration
All G4+ Plug-In ECUs are shipped with base configuration settings. Note that these are provided to reduce
initial setup and tuning times. They are NOT recommended tuning values. PCLink includes base
configurations for various models. Download the appropriate base configuration into your ECU with PCLink
by connecting to the ECU (described in the Connecting To PCLink section of this manual), then selecting
'Open' under the 'File' menu. Select the appropriate .pcl file and then select 'Open'. Downloading large
configuration files can take up to a few minutes. Be patient and acknowledge any messages PCLink shows.

6.3

MAP Sensor Calibration
At key on and engine not running the Manifold Absolute Pressure (MAP) Sensor should always match the
Barometric Absolute Pressure (BAP) Sensor. As well as providing altitude correction, the BAP sensor also
allows the MAP sensor to be calibrated prior to tuning.
Link G4+ ECUs use an on-board barometric sensor that is calibrated prior to dispatch. This ensures that all
PCLink Tuning Software programs (pcl Files) give a consistent state of tune throughout the ECU range. This
allows a PCL file to be transferred between G4+ based ECUs giving an equivalent state of tune providing all
factors affecting volumetric efficiency are equal.
Without the ability to calibrate all the available types of MAP Sensors to the BAP Sensor there would be
significant affects on the accuracy of the resulting tune, especially when tuning with Manifold Gauge
Pressure (MGP) as a load index.
To calibrate the MAP sensor:
1. Connect a laptop/notebook PC to the ECU and connect to the ECU using PCLink.
2. Under the Analog Channels menu, select the An Volt channel that has been wired to the MAP sensor.
Select the correct MAP Sensor Type.
3. Under the 'Options' menu, select 'MAP sensor calibration'.
4. Follow the on screen instructions.
5. Select the 'Analog Inputs' tab in the runtime values section of PCLink (lower part of the screen).
6. Compare the MAP and BAP values and ensure they have a similar reading (within 1 kPa).
7. Perform a 'Store' by pressing F4.

6.4

TPS Calibration
The Throttle Position Sensor (TPS) is used by the ECU to calculate various engine management parameters
used by functions such as idle speed control,acceleration enrichment and motor sport features. It is
important that the ECU knows when the throttle is open and closed (or part way in between). The following
procedure calibrates the ECU to match the TPS:
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1. Connect a laptop/notebook PC to the ECU and connect to the ECU using PCLink.
2. Under the Analog Channels menu, ensure that the correct An Volt channel is set to 'TPS (Main)'. Refer to
the pin functions section of this manual for details.
3. Under the 'Options' menu, select 'TPS calibration'.
4. Follow the on screen instructions.
5. Select the 'Analog Inputs' tab in the runtime values section of PCLink (lower part of the screen).
6. Ensure the Throttle Position value reads 0% when the throttle is closed and 100% when fully open.
7. Perform a 'Store' by pressing F4.

6.5

IAT Sensor Selection
This section only applies when an Intake Air Temperature (IAT) sensor has been wired and fitted to the intake
system. It is important that the ECU is calibrated to match the sensor installed in the engine. This procedure
is as simple as selecting the correct sensor type as follows:
1. Connect a laptop/notebook PC to the ECU and connect to the ECU using PCLink.
2. Click on 'Analogue Channel' in the configuration tree.
3. Select the An Temp channel the sensor has been wired to.
4. Ensure that channel (and only that channel) is set to 'Inlet Air Temperature'.
5. Select the correct 'Temp Sensor Type'.
6. Select the 'Analog Inputs' tab in the runtime values section of PCLink (lower part of the screen).
7. Ensure that IAT reads the correct temperature.
8. Perform a 'Store' by pressing F4.

6.6

Input and Output Setup
As the Link G4+ Plug-In ECUs are designed to run several models there are a few items that must be set-up
to make the ECU specific to your model.
The Pin Functions section of this manual gives a list of the functions of each channel based on the target
vehicle.
It is the tuners responsibility to make sure that the following channels are set-up correctly for the vehicle
model the ECU is fitted to:
All Auxiliary Output Channels
Use the 'Test On' or 'Test PWM' (at 10 Hz) functions to test the wiring of channels.
All Digital Inputs
Look at the Digital Inputs runtime values (lower section of the PCLink screen) to confirm each channels
operation.
All Analogue Volt and Temperature Inputs
Look at the Analogue Inputs runtime values (lower section of the PCLink screen) to confirm each channels
operation.

6.7

Trigger Calibration
The following instructions assume that all pre-start set-up instructions given in previous sections have been
completed. Only after all pre-start checks have been made should an attempt be made to crank the engine.
The following steps must be performed before an attempt is made to start the engine to ensure the G4+ ECU
is calibrated to precisely measure engine position.
1. Connect the ECU to PCLink.
2. Select 'Fuel', then 'Fuel Set-up':
a. Set ‘Injection Mode’ to OFF. This will prevent the engine from trying to start while the triggers are
calibrated.
b. Perform a Store (press F4) to make sure fuelling is not re-enabled if power to the ECU is lost.
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3. Click on ‘Triggers’ then ‘Calibrate Triggers’.
4. Perform the correct trigger calibration procedure specific to your vehicle as described in the PCLink online
help (Press F1).
Note that trigger calibration must be performed again once the engine is running. Due to the acceleration and
deceleration of the crankshaft at low speeds, an inaccurate measurement of engine timing is usually made.
Also it is often harder to see timing marks with a timing light at slow engine speeds. Trigger calibration
should be checked again at between 2000-4000 RPM where engine speed is stable and a more consistent
timing reading can be obtained.

(c) 2009 Link ElectroSystems Ltd
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First Time Startup
After performing all set-up instructions given in previous sections, including trigger calibration, the engine is
now ready to be started. The following procedure should be used for first time start-up.
1. Turn the ignition key OFF then ON. The fuel pump should prime momentarily upon power up.
2. Connect the ECU to PCLink.
3. Access the runtimes values by pressing the F12 Key, click the 'Analog' tab:
a. TPS – spans from 0 to 100% when throttle is pressed. If not, perform a TPS Calibration.
b. MAP – should read approx 101 kPa (at sea level) with the engine not running. If not, check the MAP
Sensor Type setting and perform a MAP Calibration.
c. ECT – should read current engine temperature.
d. IAT – should read current intake air temperature.
e. Digital Inputs (click the 'Digital' tab) – Operate switches connected to any digital inputs while watching
the runtime value to ensure they operate as expected.
4. Rectify any faults found in Step 3.
5. Locate the 'Master Fuel' setting. This can be found in the ECU Settings Menu under: Fuel > Fuel Setup >
Fuel Main.
a. This will need to be adjusted during or just after start-up.
6. Crank the engine until it starts. Some throttle may be required for first time start-up due to imperfect
tuning. If necessary adjust the Master setting to enrich/lean the engine (increase to enrich).
7. If the engine fails to start after several attempts, do not crank it endlessly. Stop and determine the
problem before continuing.
8. Check the Trigger Error Counter (found under the Triggers runtime values tab). If this value increases
during cranking/running then there is a trigger setup fault. It is not unusual for this number to count one or
two on the first engine revolution.
9. Once the engine starts, adjust the ‘Master’ (under fuel settings) setting to achieve best possible running.
10.The engine should now be allowed to fully warm up. It may be necessary to readjust ‘Master’ several
times to maintain smooth running. Don’t forget to keep an eye on engine temperature.
11.Once the engine is warmed up and running well, perform another trigger calibration (known “as setting the
base timing”).
12.Perform a Store by pressing F4.

7.1

Final Checks
To avoid potential engine damage and wasted time, the adjustments presented in the following sections must
be made before attempting to start the engine.
For further help on any of the settings discussed below, consult the online Help in the PCLink Tuning
Software. Online help can be invoked by pressing F1, or right clicking any item and selecting ‘What’s this?’.
Pre-set-up Checks
Before attempting to configure the ECU, ensure the following tasks have been completed:
1. Ensure the ECU and all associated components are connected and correctly wired/installed.
2. Fully charge the vehicle’s battery, as the engine will be required to be cranked during the set-up procedure.
3. Check all oil and water levels are correct.
Connecting to PCLink Tuning Software
Use the following procedure to establish a connection between your Link ECU and PCLink Tuning Software
tuning software.
1. Make sure your laptop battery is fully charged or plugged in to mains power.
2. Connect the ECU to your laptop and connect to PCLink Tuning Software as described in the
'Communicating with your ECU' section of this manual.
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Essential Tuning Adjustments
It is assumed that at this stage all set-up procedures described in previous sections have been completed
and the engine is running. The following steps detail correct set-up procedures for some of the more critical
ECU parameters (note that MAP Sensor Calibration should have already been completed by now):
Injector Voltage (Dead-time) Correction
There is always a delay between the injector being energised and the injector actually opening. Likewise,
there is a small delay between the injector being de-energised and the injector closing. The opening time is
considerably longer than the closing time, however the overall result is that less fuel will flow for a given pulse
width than would be expected with an 'ideal injector'. To compensate for this the injector pulse widths are
increased to compensate for this 'dead-time'. The dead-time for a given injector is a function of the battery
voltage, differential fuel pressure and the type of injector driver (saturated or peak and hold). A typical deadtime at 3 Bar differential fuel pressure and 14 volts is just under 1ms (ms = millisecond = 1 thousandth of a
second).
In applications with a linear 1:1 fuel pressure regulator (i.e. not a rising rate regulator), the differential fuel
pressure (difference between manifold pressure and fuel pressure) will be constant. Therefore the only
variable that is changing will be the battery voltage (this changes with electrical load and sometimes engine
speed). Without correction, the changes in dead-time will cause the engine to run lean when the voltage
drops. If the Injector Voltage Correction is properly set-up then changes in the battery voltage will not affect
the air/fuel ratio.
The injector dead-time table allows the dead-time for different battery voltages to be entered. The values
represent the dead-time in milliseconds. These should increase with falling system voltage.
Injector dead-time for a particular set of injectors can be determined using a flow bench or on a running
engine.
To determine the injector dead-time using a flow bench, the injectors need to be operated at the intended
operating pressure (normally three bar) and at a constant duty cycle as well as a set voltage. Vary the
supply voltage to the injector and measure minimum pulse width at which the injectors will flow for a
particular voltage. This is the required dead-time for that injector at that tested voltage.
To determine injector dead-time on a running engine, with the engine fully warmed and operating at stable air/
fuel ratios (a very precise AFR meter is required – a narrow band O2 sensor will not suffice), electrical drain
needs to be applied to the system; the preferred method is disconnecting the alternator main fuse. Battery
load testers are also useful here too.
Watching the air fuel ratios change while the battery voltage drops, the dead-time table can be trimmed to
maintain the same stable air/fuel ratio. Injector dead-time can be viewed as a row graph. A smooth curve
needs to be maintained at all times.
NOTE: any change to the fuel pressure or injectors will require a recalibration of the injector dead-times.
Master
Master should be set so that the numbers in the middle of the fuel table end up around a value of 50. This is
to allow sufficient span of the numbers in the main fuel table.

(c) 2009 Link ElectroSystems Ltd

Pin Functions

8

19

Pin Functions
A list of pin functions is provided, this is useful when configuring your ECU through PCLink.

8.1

Mazda Miata/MX5/GT-X
Miata/MX5 1600

Miata/MX5 1800

Fam ilia GTX/GTR

Auxiliary Outputs
Aux 1

ISC

Aux 2

-

Condensor Fan Relay

Over Boost Buzzer

Aux 3

-

-

FP Speed Relay

Aux 4

CE Light

-

Aux 5

-

FP Relay

Fuel Pres. Reg. Sol.

Aux 6

-

Fuel Pres. Reg. Sol.

Turbo Light

Aux 7
Aux 8

Purge Solenoid
-

-

Engine Fan Relay

Aux – Injection Outputs
Aux - Inj 5

-

Aux - Inj 6

-

Aux - Inj 7

-

Aux - Inj 8

-

Aux – Ignition Outputs
Ignition 1

Igniton 1/4

Ignition

Ignition 2 / Aux – Ign 2

Igniton 2/3

Boost Solenoid

Aux – Ign 3
Aux Ign 4

A/C Relay
-

Engine Fan Relay

-

Analog Channels
An Volt 1

-

TPS Signal

An Volt 2

Oxygen Sensor Signal

An Volt 3

MAP Signal (On board MAP sensor)

An Volt 4

MAF Signal

An Volt 5

Expansion Connector

An Volt 6

Expansion Connector

An Temp 1

ECT

An Temp 2

IAT (AFM)

An Temp 3

Expansion Connector

Digital Inputs
DI 1

A/C Request

DI 2

PS Sw itch

DI 3

-

Vehicle Speed

DI 4

Start Signal

DI 5

Neutral/Clutch Sw itch

DI 6

Expansion Connector
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Pinouts
Pin information is provided to assist when troubleshooting. All pinouts are looking into the ECU (wire side).

9.1

Mazda Miata/MX5/GT-X

Pin

ECU Function

Pin

ECU Function

1

Injection 3

45

DI 2

2

Aux 1

47

Aux – Ign 4

3

Injection 1

48

Aux – Ign 3

4

Aux 2

49

Ignition 2 / Aux - Ign 2

5

An Temp 1

52

+14V Main Relay

6

An Volt 4

13

Ground

7

An Volt 1

10

Trig 2

11

Trig 1

14

Injection 4

15

Aux 7

16

Injection 2

17

Aux 5

18

Aux 6

Expansion 1

Signal Ground

19

An Temp 2

Expansion 2

+5V Out

20

An Volt 2

Expansion 3

-

33

DI 1

Expansion 4

DI 6

35

DI 3

Expansion 5

An Volt 5

37

Aux 3

Expansion 6

An Volt 6

38

Ignition 1

Expansion 7

-

39

Aux 4

Expansion 8

An Temp 3

40

DI 4

42

DI 5

44

Aux 8

Other Connections

On Board MAP

An Volt 3
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Known Issues
All plug-in ECUs are fully tested on a range of relevant vehicles, although there are often variations that have
not been tested. For this reason issues can arise.
WARNING: Always download the latest Installation Manual from LinkECU.com and check the latest status of
known issues before installing the ECU.
Please contact your nearest Link dealer when suspecting a compatibility issue.

10.1 Mazda Miata/MX5/GT-X
There are currently no known issues.
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